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Things to Mastering More Advanced Appendices

Remember the Basics Techniques

About this Manual

Notation Conventions

The contents of this manual are classified according to the following symbols.

1) IMPORTANT

e The “Important” sections contain operating precautions or important topics.
Ensure that you read them.

@ HINT ]

e The "Hint"” sections contain procedural suggestions and tips for your convenience. Read them as
necessary.

Operating Environment

* This manual uses Windows Vista screen shots and procedures in the explanations.
The screen shots and procedures may appear slightly different if you are using
another version of Windows.

e The displayed screens and procedures may also differ slightly from the examples
depending upon the camera or printer model in use.

e The explanations in this guide are based on the premise that a Canon compact
digital camera will be used with the software.

e Some functions may not be available depending on the camera model.

Word Searches

This document is provided as an Adobe Reader document. Use Adobe Reader’s Search
functions to find specific words or phrases that you recall but cannot find. To access
this function, in Adobe Reader click the [Edit] menu and select the [Search] option.

If you are using Adobe Reader 8 or later, you can also perform searches with the [Find]
function right on the toolbar.

B8 Adobe Reader
File Edit View Document Tools Window Help

B G e$ /2[00 x5 [ ] Fn

Input search text here
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Remember the Basics Techniques Appendices

Precautions for Connecting the Camera to the Computer

e \WWhen connecting the camera to the computer with an interface cable, make sure to connect
the cable directly to the computer’s USB port. The connection may not operate correctly if
you attach the camera to the computer via a USB hub.

e The connection may not operate correctly if you are using other USB devices, excluding
USB mice or keyboards, at the same time as the camera. If this occurs, disconnect the other
devices from the computer and try reconnecting the camera.

* Do not connect two or more cameras at the same time to the same computer. The
connections may not operate correctly.

* Do not allow the computer to go into sleep (standby) mode while a camera is connected
via the USB interface cable. If this does happen, do not disconnect the interface cable. Try
to awaken the computer with the camera in the connected state. Some computers will not
awaken properly if you disconnect the camera while they are in sleep (standby) mode. Please
refer to your computer manual for instructions regarding the sleep (standby) mode.

* Do not disconnect the camera from the computer if CameraWindow is displayed on the
screen.

{1) IMPORTANT

e You are recommended to use an AC adapter (sold separately) when connecting
to a computer. Ensure that you use fully charged batteries if you cannot use an
AC adapter.

* See the Camera User Guide for procedures on connecting the camera to the
computer.
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Things to

Remember

The Two ZoomBrowser EX Windows

Windows That Communicate With the Camera and Manage Images

The following two windows are the main ones used for ZoomBrowser EX procedures.

Transfer window, which opens when a camera is connected.
CameraWindow

[ fo,

You can transfer all or a selection of images from the connected camera.

—— T— ——
CameraWindow closes and the screen changes
after the images are transferred from the camera.
Organizing window for transferred images.
Main Window g

ZoomBrowse
rExX
: Double-click this icon

on the desktop.

Double-click — —
an image. T
You can view, edit and print the images in the The Viewer Window that
computer. appears when you view
an image.

@ HINT

Use the Help Function
The [l (Help) button or Help menu is available in most CameraWindow and ZoomBrowser EX windows. It

is there for when you are unsure how to proceed.

=
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Remember

Main Window

How to Display the Main Window

Main Window will appear after the camera images are transferred and
CameraWindow closes. You can also display it by double-clicking the
ZoomBrowser EX icon on the desktop. ZoomBrowse
rEX
Names of the Main Window Parts
Menu Bar Function Buttons Display Control Panel
| o viewiiuge 4] Properties ia SideShow | ¥ Sewch (] Deete ijﬁnﬂuzz)
Task Buttons z;::; -G\ QM-8 M= )| ° &7 Fam 2)

Selects tasks to

perform. £

Last Acquired Images —
Displays the last images

transferred_ IMG_0003 JI-"C :
[ = B Pictures
Folder Area Lo J 209,08 07
L s D8 08
Selegts a folder § 205000
to display. i 209,080
1 20090811
4 Search Resules
Add.. Flamavn
Belatted Kumg

Browser Area
Icons that indicate

=1 :Image recorded using the camera’s Stitch Assist mode image properties display
m : RAW image around images, as

- Movie shown on the left.

: Image with sound memo attached

E : Protected image

. - Image recorded using the camera’s AEB function

e
: Rotated image (rotated in display only)

(‘l‘; ‘a <J . ?/\)
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Remember

How to Perform Tasks

Selecting Tasks and Task Window Procedures

Many ZoomBrowser EX functions can be accessed by selecting a task in the Main
Window and following the instructions in the guidance section of the new window.
For further details on the functions, refer to “List of Available Functions” in the

appendix.

" Select a task.

—————

Cancels the procedure and
returns to the previous
window.

Edit Samngs

@

_ The major steps for the
' l task appear here.
Follow the steps in order.

You can return to a
f previous step.

An overview for the
selected task appears here.

ZoomErowiar EX déte

. which tanl 1o use bse |

Seloct the aditing functon whaol | your
mieiki

B Rid Sy Comection..
7 Auto Adjustment.. “ipw can alsg edil he g
 Coloy on exdemnal impge adib
' Sharpnass.

O T,

© bnean Teat

o Edi with extgmal imege edibor:

2 Follow the instructions

to perform the task.
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Things to More Advanced
Remember Techniques

Transferring Images

Appendices

Transferring Images by Connecting the Camera to a Computer

Transfer the camera images to the computer.
. \oszd
e
L e, ;’dh,, ]

1) IMPORTANT

¥

* The instructions in this software manual assume that you have correctly installed
the software. See the Camera User Guide for software installation procedures.

¢ For details on how to connect the camera to a computer, refer to the Camera User
Guide. Please also refer to “Precautions for Connecting the Camera to the Computer”.

e With some versions of Microsoft Windows, CameraWindow may not open when
the camera is connected. In this case, double-click the ZoomBrowser EX icon on the
desktop to start ZoomBrowser EX and open the Main Window. Click the [Acquire &
Camera Settings] task button, followed by [Connect to Camera].

1 Connect the camera to the computer with the supplied interface cable.

2 Turn on the camera power, set it to playback mode and prepare it to

communicate with the computer.

When a window similar to the one at
the right appears, click [Downloads
Images From Canon Camera using Canon
CameraWindow].

With Windows XP, click [Canon Camera\Window]
then [OK] in the AutoPlay window.

For Windows 7, use the following steps to display
CameraWindow.

1. Click =1 on the task bar.

L

21| AutoPlay

(ﬂ|
©

e Canon XoO000000
O

] HNhways do this ter this devices

Device options
[P I Impart picturas

Set ButoPlay detaults in Control Pane

2. Inthe screen that appears, click the &= link to modify the program.
3. Click [Downloads Images From Canon Camera using Canon CameraWindow], then

click [OK].
4. Double click ¢£§.




Mastering

the Basics

CameraWindow (Menu Screen)

4 Click [Import Images from

Camera], and then click

[Import Untransferred

Images].

Only images that have not yet

been transferred will start to

transfer.

After you click [OK] in the
dialog that indicates the transfer
is complete and close the
CameraWindow screen, the
transferred images will display in
the Main Window.

|| et (e stode | Frrembom]
[ Q-0-0y

et P

You can select the newly
transferred images by their
shooting dates or My Category
(select models only) classification.

!]. - Folders containing ——= T
newly acquired images

* Images from memory cards with large numbers of images (more than 1,000) may not transfer
correctly. If this happens, please use a memory card reader to transfer. For details on transferring
images from a memory card reader, refer to “Transferring Images Using a Memory Card Reader”.

* Movie files take time to transfer since the files are large.

~ @ HINT

Changing the Transfer Destination Folder

The default settings save transferred images into

the [Pictures] or [My Pictures] folders. To change the
destination folder, click the |gg button shown on the
right in Step 4 as described above, then click the [Import]
button. In the [Folder Settings] tab, click [Browse] to
complete settings in the screen currently displayed.

(Abre of Contents ) < 0
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the Basics

~ @ HINT \

Select Images to Import
To transfer only a selection of images from
the camera, click [Import Images from
Camera] in CameraWindow (menu screen),
then select images in the image transfer
screen, and click the | 41| (Import) button.

For details, refer to “Image Transfer Screen”.

Import All Images
To transfer all images on the camera,

click [Import Images from Camera] in
CameraWindow (menu screen) then, [Import
All Images].

Automatically Transferring Images on
ZoomBrowser EX Start-Up

To automatically transfer images when
CameraWindow starts up, click the button
shown on the right in CameraWindow
(menu screen), then click the [Import]
button, and the [Auto Import] tab. Add

a checkmark to [Start importing images
automatically when this software is
launched.].

Transferring Images Using a Memory Card Reader

An action selection window will open when you insert a memory card into the memory card reader. If you
select [View/Download Images Using Canon ZoomBrowser EX], ZoomBrowser EX will start and display the
following window. Use this window to perform the transferring procedures.

ZoomBrowser EX Canon
I Transfers all images that have not yet been
[ Download Images transferred.
mm"ﬁ;:;’ | Allows you to select and transfer images.
\:} [ Print Menu Prints images.

Configures the transfer folder and
other settings.

(A )(rabte of contents ) « 1 )
B —
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the Basics

Printing

Printing a Single Image on a Single Page

Prints one image per page.

@ HINT

Printing Movies
Movies cannot be printed, but you can extract still images from movies, and print them after they have
been saved. For details on how to save still images from movies, refer to “Extracting Stills from Movies”.

" Click the [Print & Email] task button in the Main
Window.

2 Click [Photo Print].

3 Confirm that [1. Select
Images] is chosen and select

images for printing.

(' Table of Contents )
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the Basics

4 Click [2. Printer and Layout Settings] and set the categories as desired.

Sets the printer, paper
size and borderless
printing settings.

Click here to crop and print a portion of an image.

Click here to insert text
onto an image and print.

A ar Mindify tert o ping with

LTJ this phig,

Insari Tt

2 L 'i .'.‘MU[ 'C-I;mn. B % Tatal: 3 pages

[ cpmion Jil P ] [ cosm |

Sets the shooting date/time imprint settings.

Click [3. Print].
Printing will start.

@ HINT

Printing Using Other Software

If you have specialized printing software installed on the computer, you can also use it to print the
images. Click the [Print & Email] task button in the Main Window, followed by [Print Using Other
Software].

Y Table of Contents )
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the Basics

Index Print

Prints an index of the images.

" Click the [Print & Email] task button in the Main
Window.

2 Click [Index Print].

3 Confirm that [1. Select
Images] is chosen and select

images for printing.

(St | P
000 g-9-F4 .

‘ .‘ { Table of Contents )
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the Basics

4 Click [2. Printer and Layout Settings] and set the categories as desired.

Select an image to
rotate or trim.

Rotates selected
images.

Sets the printer and
paper size settings.

Click here to crop a
portion of the selected
image and print it.

i

Sets the number of Configures the printing of the shooting information,
rows or columns. comments, headers, footers or page numbers.

5 Click [3. Print].
Printing will start.

Y Table of Contents )
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How to Use CameraWindow

First Menu Screen to Open

This screen appears when the camera is connected to your computer.
Click each button to display the available options.

Displays in-camera
memory card
information. Displays camera information.

Starts operations for
transferring images from the
camera to your computer.

Starts operations for
protecting, rotating, and
deleting images on the
camera. Also transfers images
from your computer to the
camera.

Starts operations for
uploading movies on the
camera to web services.

Starts operations for setting
the camera start-up screen,
start-up sound, and various
camera sounds. For details,
refer to “My Camera
Settings” in “More Advanced
Techniques”. This menu may
not appear depending on your
camera model.

@ HINT

Customizing CameraWindow Functions

If you click the g8 button as shown in the upper right of the screen, you can customize various functions
to make CameraWindow easier to use. You can change the automatic transfer settings, the start-up
screen that appears when starting CameraWindow, and the transfer destination folder.

{ Table of Contents )
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Image Transfer Screen

This screen appears when you click [Import Images from Camera] on the Menu screen,
then click [Select Images to Import]. Select the image you want to transfer and click
the [m button to transfer the image to y.our computer.

Viewer Window (thumbnail display) E Turns the shooting date and folder name below the
thumbnails on and off (when in thumbnail display).

Changes thumbnail size
(when in thumbnail display).

Returns to the Menu screen.

"""" Closes CameraWindow.

Import Images from Camera

' cascopnery | (L T EOE g Switches between window display
HE3 MA | 1 B3GR B =
. [ - modes.

[ 28] Thumbnail display

Preview display

Uintransfemed Images: 235 | 238

1 At mages (X%

£ Uneransieered Imanes (XXX)
+ £ D Shet -l Full screen display
* £ 2009 (XK} C . . .
v 13 G0 0xxK) Double-clicking an image switches
0 o7 pex) to preview display.
3 o8 xxx)
1 0o {xx)
7 10 ey This mark appears on images that
Qn e have not yet been transferred.
v |2 Iimaye Type

(=3 IPEG Image (XXX)
(= AW Image (XXX}

B Movie (X3X)
- (3 Foide T Transfers the image chosen
. in Viewer Window to your
| computer.
Images on the camera [ Cancels image selection.
that match the selected i
filter display in the area )
to the right. (o Selects all images.
[=]=!

Rotates chosen images :
0 O 90° to the left or right. ————— The background of chosen images turns blue.

(1) IMPORTANT
e The functions (buttons) that display will differ depending on the camera model.




Organize Images Screen

This screen appears when you click [Organize Images on Camera] on the Menu screen,
then click [Organize Images]. Clicking a folder on the left will display all images within
the folder as thumbnails (small images) on the right of the screen.

Viewer Window (thumbnail display) E Turns the shooting date and folder name below the
thumbnails on and off (when in thumbnail display).

Returns to the Menu screen. Changes thumbnail size
| (when in thumbnail display).

Closes CameraWindow.
Organize Images on Camera |
T —" [ i tmaacs fx) I = a— Switches between window display
AR MA | 1 BLGE
. TEEE modes.

Uintransfemed Images: 235 | 238

[ 28] Thumbnail display

Preview display

1 At mages (X%

] Untransierred Images (XXX)
+ £ D Shet -l Full screen display
* £ 2009 (XK} L . .
v 13 G0 0xxK) Double-clicking an image switches
0 o7 pex) to preview display.
] 08 (ea)
1 09 pexx)
7 10 ey This mark appears on images that
8 e have not yet been transferred.
v |2 Iimaye Type

(=3 IPEG Image (XXX)
(= AW Image (XXX}

B Mowie (X2%)
‘(2 Foide % Deletes the image chosen
. in Viewer Window.
L_
Images on the camera [ Protects/cancels protection
that match the selected i . for the image chosen in
filter display in the area Viewer Window.
to the right.
E‘ Transfers images on your
]

Rotates chosen images "I, computer to the camera.
.0 | ,O . 90° to the left or right.

The background of chosen images turns blue.

(1) IMPORTANT

e The functions (buttons) that display will differ depending on the camera model.
e Clicking the [ x| (Delete) button will delete the image from the camera. Exercise
adequate caution, as you cannot retrieve the deleted images.

€D =TS
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the Basics

How to Use the Main Window

Main Window

This is the main window for performing tasks in ZoomBrowser EX.

Slide Show — Search
Displays the selected images in Performs searches on images.
succession in the window.
— Delete
Properties Deletes the selected images or folders.
Displays information about a ¢ Deleted images are sent to the Recycle Bin on
selected image. the desktop.

e The association between a sound memo and
an image cannot be recovered from a file
restored from the Recycle Bin.

View Image
Displays the selected image
in the Viewer Window.
— Rotate

Rotates a selected image.

e Click the [Edit] menu and select [Rotate

Task Buttons
Selects a task to perform.

Last Acquired Images According to Rotation Information] to
You can check images rotate the original image as well in the
by shooting date or My displayed direction.

Category.

) -;.'EV-I--q- i_]w«w ] G S L‘M 14 vetae ;@nnu.

Tt & [MM.MI—_O_ ———— Display Mode
i ] | At 9 LS -1 i L B Selects a display mode
ik o for the Browser Area.

=

Display Control Panel
Configures the settings
for displaying images in
the Browser Area.

Browser Area
Displays the images in
an index list.

Pl Tk
1[5 B Puctimm
) 20090807
L 20058 e
b 2003 08 05
b 2008 0410
1 2000 08 11
3 Sesich Revlt

Folder Area

Selects a folder to display.

® You can register folders you use often as Favorite Folders ( ﬁ ). Register by clicking [Add].
To delete a folder in the Favorite Folders area, select a folder and click the [Remove] button.

(A oble of Contents S
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Display Modes

Select a browser area display mode to fit your purposes.

— = s s H

[
Zoom Mode: suited for Scroll Mode: allows Preview Mode: allows the
surveying many images. thumbnails to be viewed at a image information to be read

size suited for easy viewing. while viewing the image.

@ HINT

Magnify Thumbnails to Check Images

In zoom mode or scroll mode, positioning the mouse pointer over a thumbnail causes the image to
appear at a higher magnification in a Mouse Over window. You can also set the Mouse Over window to
not show in the (Show Information) menu.

Display Control Panel

This panel adjusts the display settings for the Browser Area.

Fit to Window
Changes the thumbnail size
to fit them into the window.

Selection Menu Select Button Display Size
Click this to select/deselect all Use this to select images Changes the size of the
images in the Browser Area. in Zoom mode. thumbnail in the Browser Area.

<010
QOO RN-0-|A]R x4 O | =

L Filter v

Show/Hide Image Information Menu |— Scroll Button Filter Tool Menu
Select here to show/hide such image Use this when in Displays only images
information as the file name or shooting zoom mode to move that correspond to
date or rating beneath the the displayed portion specific conditions.
thumbnail. of the image (drag

inside the browser
Zoom Button area).

Use this to zoom in
and out on an image.
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Browser Area Tasks

~ Change the Folder Level — Change the Display Size
The level of folder displayed can be changed with the You can change the
following procedures. display ratio (Zoom mode)
* In Zoom mode, position the mouse cursor over the or thumbnail size (Scroll
folder and click the icon when it displays. mode) with the slider.

e |n Scroll or Preview mode, double-click the m icon.
e To advance to a higher folder level, click the 0 icon.

Select Images

Clicking an image in the Browser Area selects that
image. To select multiple images, hold down the [Ctrl]
key while clicking images, or hold down the [Shift] key
and click a starting and ending image to select a range
of adjacent images.

Display Images

Double-clicking an image in the Browser Area (or
selecting the image and clicking @ (View Image)),
displays it in the Viewer Window.

Move, Copy Images

To move an image between folders, drag it over the
destination folder and release the mouse button.

To copy an image, hold the [Ctrl] key while releasing
the mouse button as above.

You can also use the same procedures to copy images
between Windows Explorer and the Main Window.

Create New Folder
To create a new folder in the Browser Area,
click the [File] menu and select [New Folder].

~ @ HINT |

Right-Click Context Menus

Right-clicking over a window or image displays contextual menus. These menus contain the functions
available in the current context as well as other convenient functions. Use the right-click menus to
increase your efficiency.

Using the Navigator

If you change the displayed zoom factor in Zoom Mode, a Navigator Window that shows the current
position will appear. In the Navigator Window you can change the position by dragging 4 or clicking
inside the window.

(Ao of conven ) < 7 >
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Properties Window

The Properties Window displays when you select an image in the Browser Area and click the Properties button. The
Properties Window does not display in the Preview Mode.

(-

Madified: 8/11,/2009
File Size: 4706 KB
. Image Size: 1600 = 1200
Data Type: JPG
Sound: |:|
Shows or hides categories. [ View Image... | [ Protect
Fath: C: AU zershumaeh Picturesh 200908 11
(%] File Marne: ~
File Name Ib0G_0007
The file name can
be changed. ?tarfiatinifnd Py Cateqgony:
. ’ Comrment; '
Star Rating and My = .
Category e am
Sets the rating for an | | il
image. — —

An icon will display if a
My Category is set.

K.epwards:

Brightress Histogram:

= Protect

Prevents an image from
being overwritten or deleted.

Comment
You can type a comment here.

Keywords
Sets the keywords used in
searches.

’ B 00
Shoating Infarmation:

[term Mame Yalue

File M ame IMG_0001.JPG H
Camera Model Mame  Canon »o00

Shooting Date/Time  8/11/2009 3.15:22 Ak
Shooting Mode Ak

T [Shutter Speed) 1/250

Ay [Aperture Valug] 71

Light ketering Center Weighted Awvg. i

[ < Previous ] [ Meuxt »

Image Selector Buttons
When multiple images are selected, you
can switch between images that display
information in the Properties Window.

Brightness Histogram

A graph of the highlights and
shadows distribution in an
image.

Shooting Information

Displays detailed information,
such as the shutter speed and
exposure compensation setting.
The camera model will determine
what information is displayed.

(A oble of Contents
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Viewer Window

Double-clicking an image in the Main Window displays it in this window.

Change the display magnification. Edit an image.
Zooming in displays the Navigator window

to show the relative position on the image.

Mavigator

Sl

- EO=oomsa
L

IGO0 (14

| s < <k

Display the shooting information.
You can configure the information display by clicking
the [Tools] menu and selecting [Preferences].

Display at full
screen size.

Set the Star Rating.

‘hbuﬂ

Display multiple
images side by side.

Shooting
information

e The [Display Original Image] button will display beneath RAW images in the Viewer Window. Click this

button to display the converted image in the Viewer Window.

* The following window will appear when a movie is displayed.

& FETma

M et imag B G eas | ANETIMVA ST

GO|% A U B L
B o ot

YOU Can eXtraCt e
stills from movies.

You can cut
portions at either
end of a movie clip.

You can control movie
playback and sound
volume.

(A )(Table of contents )
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Editing Images

(1) IMPORTANT

* The original image will be overwritten after an image is edited unless the file
name is changed before saving it. To preserve the original image intact, change
the file name when saving the edited image.

e This section introduces the procedures started by clicking the Edit task button. Images can also be edited in
a similar way by clicking the [Edit] button in the Viewer Window.

Red Eye Correction

Restores eye appearance to the original color when light reflected from the flash
makes them appear red.

@ Procedures \

] Select a task from the left
side of the window:
[Edit] and [Edit Image].

7 Select an image.
e (Click [Start] when Auto mode is selected. 3 [2. Select Editing Tool]
e Switch to Manual mode if Auto mode cannot correct the 4 [Red Eye Correction]
image, and select the location of the eye to correct. o
5 [3. Finish]
* Movies and RAW images cannot be
edited.

Auto Adjustment
Automatically adjusts the image color balance and brightness.

@ Procedures\

| Select a task from the left
side of the window:
[Edit] and [Edit Image].

Select an image.

[2. Select Editing Tool]
[Auto Adjustment]

[3. Finish]

e Movies and RAW images cannot be
edited.

OOANOWN
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Color/Brightness Adjustment

You can adjust image color balance and brightness using a variety of methods.

Brightness, 1 N
@ E 6 Procedures
Contrast | Select a task from the left
side of the window:
[Edit] and [Edit Image].
Select an image.
[2. Select Editing Tool]

[Color/Brightness
Adjustment]

5 [3. Finish]

® Movies and RAW images cannot be
edited.

A WN

Level AdjustmentJ

Tone Curve Adjustment J

Adjusting Sharpness—-Emphasizing Outlines

Makes images appear sharper by emphasizing the outlines of subjects, such as people
and objects.

@ Procedures )

] Select a task from the left
side of the window:

[Edit] and [Edit Image].
Select an image.

[2. Select Editing Tool]
[Sharpness]

[3. Finish]

* The Unsharp Mask [Radius] is the size
at which the outline is detected and the
[Threshold] is the standard value at which
the outline is determined.

* Movies and RAW images cannot be
edited.

ONWN
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Trimming-Cropping a Portion of an Image

Use this to delete unnecessary portions of the image and leave only the necessary
portions.

@ Procedures \

] Select a task from the left
side of the window:
[Edit] and [Edit Image].
Select an image.

[2. Select Editing Tool]
[Trim]

[3. Finish]

® You can also input values or an aspect
ratio to specify the trim area.

e Movies and RAW images cannot be
edited.

O NN

Inserting Text

Use this to insert text onto the image.

@} Procedures\

] Select a task from the left
side of the window:
[Edit] and [Edit Image].

Select an image.

[2. Select Editing Tool]
[Insert Text]

[3. Finish]

e Placing a checkmark in the [Antialias] box

causes the text edges to blend in with
the underlying image.

* Movies and RAW images cannot be
edited.

You can freely adjust the font,
size, color and text attributes.

ONWN
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Using Other Editing Software

If you register another image editing program with ZoomBrowser EX in advance, you
can use that software to edit an image selected in ZoomBrowser EX.

Registering an Editing Program

@ Procedures \

] Select a task from the left
side of the window:
[Edit] and [Edit Image].

Select an image.
[2. Select Editing Tool]

[Edit with external image
editor]

[Manage List]

it can be started from
within ZoomBrowser EX.

r g\
ZoomBrowser EX Ot_h_er Image
Editing Program

Register the program so J

O A WN

Editing Images with a Registered Editing Program

@ Procedures }

] Select a task from the left
side of the window:

[Edit] and [Edit Image].
Select an image.

[2. Select Editing Tool]

[Edit with external image
editor]

5 [3. Finish]

e The shooting information may be lost
from images recorded with the camera
and then processed and saved with
another image editing program.

e Movies and RAW images cannot be
edited.

N OON
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Attaching Sounds

You can add sound effects or background music to images and play back the sounds.

Adding Sound

@ Procedures )

] Select an image.

2
File. View Tools Internet Help

[Edit] and [Add/Remove
Sound].

e \WAVE type sound files (extension
“.wav") can be attached to images.

e Attaching a sound file to an image results
in the selected sound file being copied
into the same folder as the image file.

AN

)

Symbol displayed on image

thumbnails to which sound
files have been addey

Playing an Image Sound File

@ Procedures \

| Select an image.

2
File. View Tools Internet Help

[Edit] and [Play Sound].

Y Tabte of Contents ) < 2 p)
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Creating Panoramic Images—PhotoStitch

You can create wide panoramic images by moving the camera slightly when recording
a series of images and merging them into one image.

% Procedures\

| Select a task from the left
side of the window:
[Edit] and [Stitch Photos].

e Movies and RAW images cannot be
edited.

Use the PhotoStitch program
to create panoramic images.

@ HINT

Using the Stitch Assist Mode

If you use the camera’s Stitch Assist mode to record the images, PhotoStitch can automatically detect the
image order and merge direction, making it easier to merge the images. (Some camera models may not
feature the Stitch Assist mode.)

(1) IMPORTANT

e If a message appears, notifying you that the computer has insufficient memory,
try one of the following methods to solve the problem.
¢ Close all other applications other than PhotoStitch.
e Reduce the size or number of images to combine.
* In the [Save] tab, select [Adjust image...], then in “Saved Image Size” reduce
the size.
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Editing Movies

You can create original movies by linking movie clips and still images.
You can even add titles and other text, background music and various special effects

to the movie.

e} Procedures )

] Select a task from the left
side of the window:
[Edit] and [Edit Movie].

.

r

EEEEENEEEENNEENENEENERNENER
EINREENENEN YENNENRENERRD

-

xR

~ @ HINT |
Recordable Movie Length
e The length of movies you can save is shown at right. A Movie Size Max. Length
message will appear if you try to save a longer movie. 1920x1080 Under 10 minutes
Reduce the length or size of the movie if this happens. 1280x720 Under 20 minutes
640x480 Under 30 minutes
320x240 Under 60 minutes
\ y,

(1) IMPORTANT
e Movies edited with this function cannot be transferred back to the camera.
e Saving movies takes time, especially MOV type movies selected with [Save
image type] takes a considerable amount of time.

QD EETD Z RS
-



Things to More Advanced

Remember

Mastering

the Basics Appendices

Converting RAW Images-Digital Photo Professional

You can convert RAW images to JPEG and TIFF images.

Digital Photo Professional’s Main Window %

Select a task from the left
side of the window:
[Edit] and [Digital Photo
Professional Process RAW
Images].

/. Select a RAW image in
| Digital Photo Professional’s
Main Window.

| 3 CIickE

(Edit image window).

Adjust the image brightness
and white balance in the

Selects folders containing images. tool palette.
| e The modified contents (the
Digital Photo Professional’s Tool Palette information for image processing

_ requirements) are saved along
You can adjust all three RGB channel

: with the image as a “recipe”.
levels together or separately with the , o ,
Wie e, e With Digital Photo Professional,

you can adjust images to achieve
the best results for your desired

GG8 | Nt ansiai s Reduces noise that occurs when scene or subject by specifying a
e ‘=2 shooting night time scenery, or picture style.
Hen et 4| Vwhen shooting at a high 15O speed. e The items available to be modified
%;-Mm : differ depending on the camera
. . , model.
Adjusts the brightness, white .
- Casse. ) balance and picture style. [File] and [Convert and
: savel.

e After setting the file type, size,
and destination folder, click [Save].

T —— .Tﬂ e Only RAW images compatible with Digital

iy ; , Photo Professional can be processed.

cmmwlm..;.. - Aolljusts the gontrasé, cholor tone, « Ensure that you use the RAW image
color saturation and sharpness. conversion software included with your

Color saturation () |
camera.

SharpnessiT) J

€ < 3 >
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To print, using Digital Photo Professional, select an image in the Main Window, then
click the [File] menu and select the print function. Digital Photo Professional offers the
following printing methods.

Printing Method Description

Single Print Automatically sets the layout for printing a single image on a single page.

Detailed Setting Gives you the freedom to set the layout, add titles, or print with shooting information.

Prints a line-up of multiple images on one page (also allows you to select the number of

Contact Sheet images, layout, and add titles).

(1) IMPORTANT

e RAW images can only be captured on certain camera models that list "RAW" as one of
the data types included in the “Specifications” section of the Camera User Guide.

e Only RAW images compatible with Digital Photo Professional can be processed. Check
the “Data Type” item of the “Specifications” section of the Camera User Guide for
compatibility.

* For a more detailed explanation of operating procedures, download the Digital
Photo Professional manual (PDF format) from the Canon website.

~ @ HINT ~

About RAW Images

RAW images contain the data captured by the camera’s image sensor without modification. Since

they contain raw data that differs from the usual JPEG images by not having any image adjustment or
compression processing performed in the camera, they can be converted on a computer with a lossless
process.

Processing in the Camera Processing by Computer
6) Image Ad_justment

e Can be used with general programs.

Standard Image

Capture Compression JPEG Image ¢ Image is subject to degradation when
Image sensor | Image adjustment adjusted because it has been compressed.
data from & compression

Digital Photo Professional

shutter release | automatically performed RAW Image Processing

RAW Image (Image Adjustment)

Capture (RAW Image)—> . JPEG Image,
( Compression ) TIFF Image

* You can view the image while making
adjustments without worrying about quality
loss.

e Processing with Digital Photo Professional
is required to view the images with general
programs.

. J
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Exporting
Changing Image (Stills) Sizes and Types

You can change an image’s size and format when exporting it so that it can be
published on the Internet or attached to an email message.

@ Procedures )

] Select a task from the left
side of the window:
[Export] and [Export Still
Images].

* You will lose the shooting information
if you save images as a type other than
JPEG.

Changing Movie Sizes and Types

You can change a movie's size and format when exporting it so that it can be
published on the Internet or attached to an email message.

@) Procedures \

] Select a task from the left
side of the window:
[Export] and [Export
Movies].

e You can also use this function to rotate
movies.

(1) IMPORTANT

e Exporting movies may take a
considerable amount of time.

<« n )
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Extracting Stills from Movies

You can extract and save stills from your favorite frames recorded in a movie.

EEENENEENNNNENENNNNNEENENNNNEENNNEENEEERERN (@ Procedures\

FH! ,-:g! ?I EL | Select a task from the left

lllllllllllllllllllllllllllllllllllll Sldeofthewindow:
[Export] and [Extract frames
from a movie].

Extract your best
shots as stills

Exporting Shooting Information

You can export the shooting information recorded with an image, such as the shutter
speed and exposure, as a text file.

@ Procedures\

| Select a task from the left
side of the window:
[Export] and [Export
Shooting Properties].

failed photos or compare the

Ascertain the causes of
settings for several images.

(A ebre of Contents ) <
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Creating Computer Screen Saver Images

You can export images to serve as computer screen savers.

@) Procedures\

| Select a task from the left
side of the window:
[Export] and [Export as a
Screen Saver].

Creating Computer Wallpaper Images

You can export images to serve as computer wallpaper images.

@ Procedures )

] Select a task from the left
side of the window:
[Export] and [Export as a
Wallpaper].

< 3 p)
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Saving to CDs

You can save images along with their shooting information to CD-R/RW discs.

?} Procedures\

] Select a task from the left
side of the window:
[Export] and [Backup to CD].

Back up important images
or distribute your vacation
photos on discs.

(1) IMPORTANT

e This function can only be used with computers that satisfy the following
requirements:

e Equipped with a CD-R/RW drive as standard equipment
e Writing to the CD-R/RW drive operates correctly with Windows

e |f a window similar to that shown to the right appears when
a new CD-R/RW disc is placed in the drive, click &34 ([Cancel] ] _
when using Windows XP) to close the window. Q DVD RW Drive (G)

Always do this for blank CDs:

Blank CD options
Burn an sudio CD
using Windows Media Flayer
" Burn files to disc
using Windows

Set AutoPlay defaults in Control Panel

< 3% p)




More Advanced

Techniques

Uploading Movies to YouTube
Uploading to YouTube

You can upload movies you have shot to YouTube. You can upload movies saved on

the camera or a computer.
//l‘\\ ‘ @} Procedures\

] Connect the camera
((’!.El to a computer to start

CameraWindow.

* For details, refer to steps 1- 3 in
“Transferring Images”.

[Upload Images from
Camera]

[Upload Movies to YouTube]
Select movies.

Click (4] (Next).

Input a title and description,

then click [2] (Upload).

Enter your YouTube
username and password,
and sign in.

I

| OO A W N

Uploading Movies Saved on a Computer

Click the [Start] menu at the bottom left of the screen and select [All Programs] or [Programs] followed by
[Canon Utilities], [CameraWindow], [Movie Uploader for YouTube] and [Movie Uploader for YouTube]. Click
[Add] in the screen that appears, then after adding movies to the upload list, click the |€ | (Upload) button.

(1) IMPORTANT

e Depending on YouTube specifications, or future changes to specifications, this
function cannot be guaranteed.

* The maximum length for uploadable movies is less than 10 minutes, and the
maximum file size is less than 1 GB.

* Movies that have been edited on a computer cannot be uploaded.

e Internet access is required to upload movies (You must already have an account
with an Internet service provider (ISP), browser software installed and an
Internet connection).

e Any ISP account charges and access fees must be paid separately.
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Attaching Images to Email

You can send images as email file attachments.

Click here for most images. Click here when you want to 5 N\
change the image size or image 6 Procedures
quality settings, then click [Custom 1 Select a task from the left

Settings] to change settings. side of the window:

[Print & Email] and [Email
Images].
7 Select an image to send.

* You can also select multiple
e images or all images in a folder.

st b N B s s

% -

File [3 View Tools ldeme Hes

Using the recommended satings
Using cusfom sefings

G CoomCioeBoss 3 Click [2. Change Image Size]
I @& * You can change the image size
Emal Atachmert S, o and quality settings.
Ales Firestiong the Task Laursch celaul srmad applcalion . .
- 4. Click [3. Finish]
‘IL' e The mail software will start, and the
' _ _ send screen will appear. The selected
Cllgk here to check the = Click here to preview the image will appear as an attached file.
options currently set. compressed image.

e In [Custom Settings], if [Save
Click here to check what the to Folder] is selected in “After
actual compressed file size will be. Finishing the Task”, the selected
images will be saved in the
indicated destination folder.

~ @ HINT |

Automatic Start-up Settings for E-mail Software

e \When using Windows 7, you must pre-install an e-mail program. When changing settings, set the
default program in the Control Panel.

e \When using Windows Vista, configure the settings in your e-mail software. For example, you can
configure Windows e-mail by starting e-mail, then clicking the [Tools] menu, followed by [Options],
[Default Messaging Programs], [This application is not the default Mail handler], and [Make Default].

e \When using Windows XP, settings can be configured by starting the Internet Explorer program, and clicking
the [Tools] menu, followed by [Internet Options], [Programs] tab, and the [E-mail] pull-down menu.

J
(1) IMPORTANT
* The e-mail’s MAPI client must be preset for the e-mail software to start automatically.
¢ If the e-mail software does not start automatically, first save the images to your
computer, then start your e-mail software to attach and send the images. The
destination folder for saved images can be set with [Custom Settings].
(A (ebte of Contents ) < 33 p
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Slide Shows

Viewing Images in Slide Shows

A multiple selection of images can be shown at full size on the screen in succession as

a slide show.

You can freely configure the
transition effects, information

displayed and display time settings.

J @ Procedures \
| Select a task from the left

\_..L

side of the window:
[View & Classify] and [View
as a Slide Showl.

~ @ HINT N
Slide Show Button Functions
The following buttons appear at the bottom of the screen while a slide show is playing.
You can set the Star
Rating for an image
while it is displayed. Rewind Pause Forward
After the slide show, After the slide show, Stops the slide show.
the images you the images you clicked
clicked during the during the show appear
show remain selected. in a printing window.
J
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Image Management

Changing File Names in Batches

You can change the file names of multiple images in one procedure.

@ Procedures\

] Select a task from the left
side of the window:
[View & Classify] and

Name + Number l
ot [Rename Multiple Files].

Shooting Dat Numb indivi i
i ooting Date + Num erJ e You can change individual file and folder

| & L .
. names by clicking the [File] menu and
Name + Shooting Date + NumberJ Change randomly selecting [Rename] or by clicking on the

. . numb ey IS file name in Preview mode.
Shooting Date + Name + NumberJ and received images . . .
e Changing the image name in

into consecutively
ZoomBrowser EX also changes the actual

numbered images.
/ — file name on the disk.

xxx_04 xxx_05

Sorting Images into Folders by Shooting Date
You can sort images into folders by their shooting dates.

@ Procedures \

] Select a task from the left
side of the window:

-' [View & Classify] and
2001/05116 [Classify into Folder].

of ZoomBrowser EX can

Images predating your use
also be managed together.

(A o of comers ) < w0 )




More Advanced

Techniques

Configuring Image Information Settings

Setting Star Ratings

You can set the Star Ratings used in searching and displaying images in the index list.

@ Procedures )

1 | Zoom Mode | Scroll Mu:uc‘ | Preview Mode
| g

Switch to [Preview Model.
7 Set [Star Rating].

e You can also set the Star Ratings by
accessing the [Edit] menu, the Properties
Window or the Viewer Window.

W ¥ : Ultimate
W :Moderate
w : Okay

Inserting Comments

You can freely insert your choice of text as Comments.

@ Procedures )

1 | Zoom Mode | S croll Mu:n:‘ | Preview Mode
| S

Switch to [Preview Mode].
7 Insert [Comment].

e Comments can also be managed in the
Properties Window.

Your choice of text
as comments

<« v >
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Assigning Keywords

You can set Keywords for use in image searches.

@ Procedures )

1 | Zoom Mode | Scroll Mu:n:‘ | Preview Mode
| S

Switch to [Preview Mode].
7 Insert [Keywords].

e Keywords can also be managed from the
[Tools] menu or Properties Window.

* To add keywords, click the [Tools] menu
and select [Manage Keywords].

~ @ HINT |

About Image Information
This chart shows the information other than shooting information that can be added to images.

Information Type | My Category Star Ratings Comments Keywords

Categories such as

Categorized on a

Text input without
restriction regarding
the shooting

Selections are made
from a list (editable)
of keywords, such

Content basis of 3 rankings: . :

People, Scenery, etc. e Ledre circumstances as the photographic
' ' or associated subject, place or
memories. action.

Configuration Configured in : .

Method X Configured in ZoomBrowser EX

Used in Searches — 0 0 O

Us_ed as Filter 0 0 o o

Criteria

Display beneath

Thumbnail O O 0 -

\.

Categories displayed beneath thumbnails can be selected by clicking in the Display Control Panel.

(A Tobre of Contens )
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Searching, Filtering and Sorting Images

Searching Images

You can search images using parameters extracted from the information associated
with them.

@ Procedures \

] Select a task from the left
side of the window:
[View & Classify] and
[Search].

e After a search, the correlated images
display in the [Search Results] folder.

A\
' Favarite Folders | gl F.:.I.:Iersl

- Jy 2009_08_08 -

-1 2009_08_09

|, 2009_08_10
g | 2009_08_11

----- %! Search Results il

m

| Add... || Remove |

Tasks Related to Search Results
You can select images in the [Search Results] folder and perform operations on them, such as printing or

copying them to other folders.

(1) IMPORTANT
e Please note that deleting an image from the [Search Results] folder deletes the
original image. Use caution in deleting items from this folder.

(A e of onters ) < s )
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Filtering Images

You can use filters to display only images meeting the selected parameters in the
Browser Area.

@ Procedures\

I EF Fiter -
[Filter]
e I T

o o ais

Frorviees Mode |

il Qb O@R-0-iE < | =
n-T;sT.l-w Wiy Wlurd Woriny
fATI:._I_I

This section is used to specify the filter criteria.

Sorting Images

You can sort images in the Browser Area based on the specified parameters.
@ Procedures )

ol caLed s I

File Edit‘ View )Touls Internet  Help
Name i N
' Shooting Date

[View] and [Sort by].

Modification
Date

Star Rating

Ascending/
Descending
Order

C
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Comparing Images

Comparing Multiple Images

When a good photo opportunity arises, you can shoot the same subject using different
shutter speeds and exposures. In ZoomBrowser EX, it is easy to compare images so that
minute differences can be detected.

@ Procedures\

| Select several images to
compare.

2 CIick@[View Image].
3 Select —, [ [ | [I[] or=in

the Viewer Window.
4 Click [€=] [Synchronize].

e Selecting [Synchronize] causes actions
such as increasing/reducing the
magnification level or scrolling around
the image to apply to all of the selected
images in lock step, making it easy to
check minute details of focus, coloring
and other image characteristics.

Actions performed on an image, such as scrolling or changing the
magnification, are performed on the other image as well.

(CA O ebte of Contents ) < 5 P
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My Camera Settings

Changing the Shutter Sound and Start-Up Image

You can select from dedicated screens to register to the start-up screen that appears
when turning the camera on, and dedicated sounds to register to various camera
operation sounds (My Camera Settings).

My Camera Settings @ Procedures\

e Start-up Image

« Start-up Sound | Connect the camera

* Shutter Sound to a computer to start

* Operation Sound CameraWindow.

¢ Selftimer Sound _ ,
— e For details, refer to steps 1- 3 in

/ “Transferring Images”.
m 2 [Camera Settings]
-5 .

Select the desired item from
the following and make
settings.

P [Set Start-up Image]
» [Set Sounds]
» [Set Theme]

(1) IMPORTANT

e My Camera Settings are only available on certain models, when [Camera
Settings] displays in CameraWindow.

(A )(ebre of Contents ) < 4 P




More Advanced

Techniques

My Camera Settings
registered in the camera.

My Camera Settings

Card Capacity:
. B63 MB /143 GA
[ —

Urirgmuherres Images: 238 / 238

You can register the
start-up image, start-up
sound, shutter sound,
operation sound

and self-timer sound
collectively if you select
[Theme].

After choosing a My Camera Settings file from the left-hand list,
select a My Camera Settings file to replace in the right-hand list
and click this button to register it in the camera.

@ HINT

Downloading My Camera Settings Files
You can also download various files to use in My Camera Settings from CANON iIMAGE GATEWAY.

(A ) 7ot of Contents ) < 7
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Transferring Images

Transferring Images to a Camera

Images transferred once to a computer can be transferred back to the camera.

@} Procedures\

| Connect the camera
to a computer to start
CameraWindow.

e For details, refer to steps 1- 3 in
“Transferring Images”.

2 [Organize Images on
Camera]
Show favorite images I 3 [Organize Images]
to friends or connect :
a TV to show them 4 @ (UPload)
on a large screen. 5 Select images.

e |f the Main Window is open when the
camera is connected (directly after
transferring for instance), open the
CameraWindow (menu screen) by
clicking the [Acquire & Camera Settings]
task button, followed by [Connect to
Camera].

(1) IMPORTANT

e Cameras that use the “MOV"” data type can play back movies transferred back to
the camera if movies were taken with that camera. Refer to the “Data Type” item
in “Specifications” near the end of the Camera User Guide to see if the camera
uses the “MOV"” data type. You may not be able to play back movies taken with
another camera.

* Only still images compliant with Design rule for Camera File system standards
can be transferred to your camera’s memory card.

e You may not be able to transfer images back to the camera if they have been
edited on a computer, or if the image information has been modified.
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CANON IMAGE GATEWAY

About CANON iMAGE GATEWAY (for U.S.A. customers only)

CANON iMAGE GATEWAY is an online photo service for the purchasers of this product.
Registering online allows you to use the various services.

(1) IMPORTANT
e Internet access is required to use CANON iMAGE GATEWAY (You must already
have an account with an Internet service provider (ISP), browser software

installed and an Internet connection).
e See the homepage for information regarding browser versions (Microsoft
Internet Explorer, etc.) and settings to best connect to CANON iMAGE GATEWAY

online photo services.
e Any ISP account charges and access fees must be paid separately.

Registering
First, register as a CANON iMAGE GATEWAY member.

s @ rrocaus
] Select [CANON iMAGE
GATEWAY] f task
‘(//‘\}\‘ g CANON the left ofth:aovr:l?in?ii)\fv,o "
i.\\\\‘ ';_g‘ I '\é /A/\TAE%E ;c:l:s:; J(ilfct [Register/Add
\\ |/

 You can register online using the
supplied CD-ROM. To do this, in the
installer panel, click [Register] underneath
CANON iMAGE GATEWAY.

Canon DIGITAL CAMERA
Solution Disk
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Available Services

CANON iMAGE GATEWAY offers a variety of convenient and useful services.

Upload and
P share images

J

Create your own photo album
on CANON iMAGE GATEWAY
E-mail notifications
of album uploads

4

Friends and family can
freely browse images

Access even from
mobile phones

My Camera Settings Files on
CANON iMAGE GATEWAY

Download files for My Camera
Settings (certain models only)

@ Procedures\

| Select [CANON iMAGE
GATEWAY] from tasks on
the left of the window.

Select the desired item from
the following and make
settings.

» [Register/Add Product]

» [Top Page]

» [View Online Photo
Album]

» [Upload Images]

» [Download My Camera
Contents]

Order prints
Order an original
collection of photos

N\

Also, you get the
latest customer
- support information,
~ just for registering
- your product

!

£
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Preference Settings

Customizing ZoomBrowser EX

You can configure ZoomBrowser EX to operate according to your preferences.

e Overall themes, such as
window appearances

* Processing methods for
images shot with the
camera on end

e Categories of shooting
information displayed

e Show/hide messages

Customizing the Task Buttons

e Print settings
e Zoom speed I

@ Procedures \

1 ll':]' foomBrowse

o JEEMS 0000 F ICTUTES

File Edit View Internet  Help

[Tools] and [Preferences].

You can hide items that you do not usually use to streamline the task buttons.

CALMertan

\ gt Propertie @“ﬂtshﬂ
|| ZoomMode | Seaoh Mode | Praview Mods|
2009 08 11 Q|H~D -

Last Acpmed |mages
[ &5 alimages

@ Procedures \

1 ll':]' foomBrowse

File Edit View { Tools § Internet  Help
N

[Tools] and [Customize].
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List of Available Functions

CameraWindow Functions

Function Names Description of Function

Import Untransferred Images Only]:trans(jers images from the camera that have not yet been
|mport |mages transterred.
from Camera Select Images to Import Only transfers chosen images from the camera.

Import All Images Transfers all images from the camera.

Protect, rotate, and delete images on the camera. Also transfers
images back to the camera from your computer.

Organize Images
on Camera

Upload Images

Organize Images

Upload Movies to YouTube Uploads movies on the camera to YouTube.
from Camera
Set Start-up Image Sets the camera start-up screen.
Sets camera sound effects (start-up sound, shutter sound,
: Set Sounds . )
Camera Settings operation sounds, self-timer sound).
Sets the camera start-up screen and sound effects in My Camera
Set Theme :
Settings.
General (General/Connected Sets the camera owner name, and start-up screen when
Camera) CameraWindow starts.

Preferences
Import (Auto Import/Folder

Seififs/AfEPTEN) Sets the automatic transfer settings and destination folder.

ZoomBrowser EX Functions

Task Button Names Description of Function

Connects to the camera to open CameraWindow (menu screen),
and use CameraWindow functions.

Connect to Camera

Acquire & Acquire Images from Memory Transfers images from a memory card. You can also select
Camera Settings | Card images on the memory card and print them.

Transfer Images to Memory Card | Transfers images from the computer to a memory card.

View as a Slide Show Starts a slide show of the images selected in the Browser Area.

Rename Multiple Files Changes the file names of the selected images in a single pass.

Classify into Folder Classifies images and saves them into a specified folder.

View & Classify Performs image searches using criteria such as the Star Rating,

modification date, shooting date, comments or keywords.

Search Star Ratings, comments and keywords can be set in the image
information column in the Preview Mode or in the Properties
Window.

-
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Task Button Names

Description of Function

Edit Image

Allows you to perform image editing, such as cropping, image
correction, inserting comments, and red-eye correction. You can
also use it to start other image editing programs.

Stitch Photos

Merges multiple images and creates a single large panoramic
image.

Edit , , —
. . Edits movies or still images strung together. You can add text as
Edit Movie . . .
titles, or background music, and apply various effects.
i . Converts RAW images into JPEG or TIFF images. You can adjust
Digital Photo Professional : .
the image brightness, contrast and color balance among other
Process RAW Images . . .
attributes during conversion.
Export Still Images AIIovys you to change the image size or type, and export it as a
new image.
EXCorMIoues Allows you to change the movie size or type, and export it as a
new movie.
. Extracts still images from movies over a specified interval and
Extract frames from a movie . .
Export saves them as image files.
Export Shooting|Properties Allows you to select thelnecessary dgta from the shooting
information and export it as a text file.
Export as a Screen Saver Exports the image as a screen saver file.
Export as a Wallpaper Exports the image as a wallpaper file.
Backup to CD Copies images to a CD-R/RW disk for backup.
Photo Print Prints one image per page. You can print “photos” easily.
Index Print Lines up small versions of the images in rows and prints.
B Print Using Other Software Select the software to use and then print.
Converts the selected images to the appropriate size for
Email Images transmission by e-mail. You can also use it to automatically start
an e-mail program after conversion.
Register/Add Ridd® Connect_s to CANON iIMAGE GATEWAY and opens the
registration page.
Connects to CANON iIMAGE GATEWAY and goes to the top of
Top Page the page
CANON iIMAGE : : :
GATEWAY View Online Photo Album Connects to CANON iIMAGE GATEWAY and displays albums

created.

Upload Images

Connects to CANON iIMAGE GATEWAY and uploads images.

Download My Camera Contents

Connects to CANON iMAGE GATEWAY and downloads images
and sounds for use with My Camera Settings.
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Supported Image Types

The following is a list of image types supported by ZoomBrowser EX.

JPEG (.JPG)

Most cameras use this image type. It compresses at very high ratios, taking advantage
of the characteristics of the human eye. However, because it is an irreversible
compression method (part of the data is lost during compression), if you process and
save an image repeatedly using this method, the image may become rougher.

RAW (.CRW/.CR2)

This is a proprietary image type provided by Canon. It saves the output of the image
pixels from a digital camera without any deterioration in the quality of the image.
Some cameras might not support this image type.

Windows bitmap (.BMP)
This image type comes standard with Windows. Most Windows programs support it.

TIFF (.TIF)

This is a relatively popular image type. It is widely supported by non-Windows
programs (such as Macintosh).

PhotoCD (.PCD)
This is the image type used for Photo CDs.

AVI (.AVI)

Standard Windows movie type. The movie thumbnail and a movie icon show in
ZoomBrowser EX’'s Browser Area.

MOV (.MOV)

Movie type. The movie thumbnail and a movie icon show in ZoomBrowser EX’s
Browser Area.
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Uninstalling the Software

The procedures for uninstalling the software are only required when you wish to
delete the programs from your computer or when reinstallation is required to fix
corrupted files.

1) IMPORTANT
e Computer administrator status is required to perform the following operation.

This explanation uses ZoomBrowser EX to demonstrate how to uninstall a program.
You can remove other programs with the same procedures.

" Click the Windows [Start] menu | 00000000
and select [All Programs] or . = eereh
[Programs], followed by [Canon | CANON iMAGE GATEWAY Task Recent Items
Utilities], [ZoomBrowser EX] and . —

[ZoomBrowser EX Uninstall]. | Personal Printing Guide

| PhotoStitch

| OO0

| ZoomBrowser EX

ﬁ ZoomBrowser EX
OOMETOWSEN EA Meadrne

Metwark
Connect To

Control Panel

¥ =
iy ZoomBrowser EX Uninstall Default Programs

Back Help and Support

A

The uninstall utility will start and remove ZoomBrowser EX.
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Memory Card Folder Structure

Images on the memory card are in either the [DCIM] folder’s [xxx___mm] folder, or the
[xxx_mmdd] folder (xxx: numbers 100 to 999, mm: shooting month, dd: shooting day).

2 Am &

xxX_mmdd

IMG_xxxx.JPG (JPEG images)

_MG_xxxx.JPG (JPEG images recorded in the Adobe RGB color space)
IMG_xxxx.CR2 (RAW images)

_MG_xxxx.CR2 (RAW images recorded in the Adobe RGB color space)
STx_xxxx.JPG** (Stitch Assist mode images)

MVI_xxxx.MQOV, MVI_xxxx. THM* (Movies)

MVI_xxxx.AVI, MVI_xxxx. THM* (Movies)

‘{ The folder that holds the settings files

for images in the DCIM folder.

CANONMSC
- '{ The folder created when DPOF settings are set.
It holds the DPOF settings files.

MisC

e * These files are the thumbnail image files for the camera’s index replay mode. If
you delete these files, you will be unable to transfer movies to the camera from a
computer.

* The “xxxx" in file names represent four-digit numbers.

e ** Each successive file shot in Stitch Assist mode is assigned a letter starting from
“A,"” which is inserted as the third digit in the name. i.e. [STA_0001.JPG], [STB_0002.
JPG], [STC_0003.JPG]...

e All folders except the “xxx__mm” or “xxx_mmdd" folders contain image settings
files. Do not open or delete them.

e Depending on the camera, some data types cannot be recorded.
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Troubleshooting

Please read this section if you encounter a problem using the software.

Start by Checking This

Investigate the following points first if you encounter a problem.

Does your computer satisfy the requirements listed in the System
Requirements section?

See “System Requirements” in the Camera User Guide.

Is the camera correctly connected to the computer?

See the Camera User Guide for the correct connection procedures. Also check to
ensure that you are using the correct cable and that it is securely attached at both
ends.

Are the camera and computer in the correct modes to transfer data?

Some models require the camera to be set to the playback mode to transfer data. See
the Camera User Guide for details.

Is the battery sufficiently charged?

Check the battery charge if you are powering the camera with a battery. You are
recommended to use an AC adapter (sold separately) to power the camera when it is
connected to a computer.
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Problems

Try the suggested solutions to the common problems listed below.

You can‘t find transferred images.
Refer to “Changing the Transfer Destination Folder” to confirm where the destination
folder is.

Add New Hardware Wizard displays when the camera is connected to the
computer with an interface cable.

Click [Cancel] to close the window. Temporarily disconnect the camera from the
computer. Next, read Start by Checking This on the previous page and resolve the
problem.

Camera not detected, Events dialog/AutoPlay/Device Stage won't display
or images will not transfer to the computer (when camera is connected to
the computer via an interface cable).

The camera may have been recognized as another device.

Solution:
Delete the device with the following procedures.

(1) IMPORTANT
e Computer administrator status is required to perform the following operation.

| Display the [Device Manager] dialog.

Windows 7, Windows Vista:

Click the [Start] menu, [Control Panel], [System and Maintenance], [System], and [Device
Manager].

Windows XP:

Click the [Start] menu, [Control Panel], [Performance and Maintenance], [System],
[Hardware] tab, and the [Device Manager] button.
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[Imaging devices] category.

Appendices

7 Click the [+] symbol beside the [Other devices], [Portable Devices] and/or

Your camera model name or [Canon Camera] will display in these categories if it is being

recognized as an “other” device.

File Action View Help

£ Device Manager

File  Action Wiew Help

-1 Computer

[y Disk drives

i B Display adapters

-y DVD/CD-ROM drives
-2 Floppy disk drives
Ej--ﬁ Floppy drive controllers
Ej--% Human Interface Devices

- IDE ATASATAPI controllers
-EZ2 Keyboards

Ej---a Mice and other pointing devices
- Bl Monitors

4 Sound, video and game controllers
c— Storage controllers

--f_lEJ System devices

i Universal Serial Bus contrallers

&= = HFEl = l«» m & 2
P x| =58

[+ ¢ Computer

[+ Disk drives

§ Display adapters

-k DVDCD-ROM drives

@ Floppy disk controllers

3‘ Floppy disk drives

--ﬁ Human Interface Devices
{2y IDE ATAJATAPT conitrollers

; llers

Elaﬁ Imaging devices

P

t-- 1y Mice and other pointing devices
]9 Monitars

r|--E8 MNetwork adapters

i Y Ports (COM & LPT)

]--ﬂ. Processors

]--@. Sound, wideo and game controllers
t-4e® Storage wolumes

Fl- b System devices
I8 Universal Serial Bus controllers

[y PO e PO O s O s O g O s 8 s Y |

There are other potential reasons for the problem if the [Other devices], [Portable
Devices] or [Imaging devices] categories do not appear or your camera model name
or [Canon Camera] does not appear. Proceed to Step 5, and temporarily quit the

procedures.

Select your camera model name or [Canon Camera], right-click and select

[Delete].

Click [OK] in the confirmation dialog.

Delete all instances of your camera model name or [Canon Camera] if it appears in one
or more places in the [Other devices] or [Imaging devices] categories.

5 Close [Device Manager] or [System Properties].
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Disclaimer

e While every effort has been made to ensure that the information contained in this guide
is accurate and complete, no liability can be accepted for any errors or omissions. Canon
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

e No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior written
permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, memory cards, personal
computers, peripheral devices, or use of non-Canon memory cards.

CDP-E088-010 © CANON INC. 2010
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